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File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Insert File... Insert a file at the current location in the document.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits Web Spinner.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Word Wrap Turn word wrapping on or off.



Search menu commands
The Search menu offers the following commands:

Find Find text within your document.
Find next Find the next occurrence of text within your document.
Replace Replace text within your document.



View menu commands

The View menu offers the following commands:

Options... View program options
Status Bar Shows or hides the status bar.
Test HTML Run your WWW viewer to test your document.



Insert menu commands
The Insert menu offers the following commands:

Paragraph Insert a Paragraph tag.
Link Insert a link to another HTML document.
Graphic Insert a graphic in the current document.
Horizontal Line Insert a horizontal line in the current document.
Line Break Insert a line break tag.
Special Symbol Insert a special symbol in the current document.
Block Quote Insert a Block Quote tag.
List Item Insert a List Item tag.
Unordered List Insert an Unordered List.
Ordered List Insert an Ordered List.
Directory List Insert a Directory List.
Menu List Insert a Menu List.
HTML Insert a HTML tag.
Title Insert a TITLE tag.
Body Insert a BODY tag.
Address Insert an ADDRESS tag.



Formatting menu commands

The Formatting menu offers the following commands:

Bold Format the currently selected text as Bold.
Italics Format the currently selected text as Italics.
Underline Format the currently selected text as Underlined.
Typewriter Format the currently selected text as Typewriter font.
Definition Format the currently selected text as a Definition.
Emphasis Format the currently selected text as Emphasized.
Citation Format the currently selected text as a Citation.
Code Format the currently selected text as computer code.
Keyboard Format the currently selected text as Keyboard input.
Status 
Message

Format the currently selected text as a Status Message

Strong Format the currently selected text as Strong text.



Heading menu commands

The Heading menu offers the following commands:

Heading 1 Format the currently selected text as a 1st level heading.
Heading 2 Format the currently selected text as a 2nd level heading.
Heading 3 Format the currently selected text as a 3rd level heading.
Heading 4 Format the currently selected text as a 4th level heading.
Heading 5 Format the currently selected text as a 5th level heading.
Heading 6 Format the currently selected text as a 6th level heading.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About... Displays the version number of this application.



New command (File menu)

Use this command to create a new document in Web Spinner

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

*.ht
m

HTML documents

*.* All documents

Drives
Select the drive in which Web Spinner stores the file that you want to open. 

Directories
Select the directory in which Web Spinner stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Web Spinner suggests that you 
save changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, Web Spinner 
displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, Web Spinner displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Web Spinner displays the Save As dialog 
box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Web Spinner adds the extension you specify 
in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Web Spinner session.    You can also use the Close command on the 
application Control menu.    Web Spinner prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar and on the right 
hand side of the window.    The toolbar provides quick mouse access to many tools used in Web Spinner,

Web Spinner has five tool bars:

Standard
Special Character
Styles
Heading
Links



Standard Toolbar

Click To
Open a new document.

Open an existing document.    Web Spinner displays the Open dialog box, in which you can locate
and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, Web Spinner displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Print the active document.

Find text in the active document.

Repeat the last find command in the active document.



Special Character Toolbar

Click To

Insert a less than (<) symbol.

Insert a greater than (>) symbol.

Insert an ampersand (&) symbol.

Insert a quote () symbol.



Styles Toolbar

Click To

Format the currently selected text as bold.

Format the currently selected text as italic.

Format the currently selected text as typewriter.

Formt the currently selected text as underlined.



Heading Toolbar

Click To

Format the currently selected text as a first level heading.

Format the currently selected text as a second level heading.

Format the currently selected text as a third level heading.

Format the currently selected text as a fourth level heading.

Format the currently selected text as a fifth level heading.

Format the currently selected text as a sixth level heading.



Link Toolbar

Click To

Insert a link to another document or source.

Insert a graphic.

Insert a horizontal line.

Insert a paragraph tag.

Insert a line break tag.

Insert a block quote tag.

Insert an unordered list tag.

Insert an ordered list tag.

Insert a list item tag.

Test the currently active Web Spinner Document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Web Spinner window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Web Spinner displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Web Spinner and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Web Spinner.



Context Help command 

Use the Context Help command to obtain help on some portion of Web Spinner.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Web Spinner window, such as another Toolbar button.    The Help topic will be shown 
for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Web Spinner window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Web Spinner determines which window
is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Web Spinner determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Web Spinner window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Find command (Edit menu)

Use this command to find text within a Web Spinner document.

Shortcut
Keys: F3



Find dialog box
Searches for specified text in the active Web Spinner document.

Shortcut
Keys: ALT+F3

Find What:
Type, or insert the information you that to find.

Match Case
Finds only text with the exact combination of uppercase and lowercase letters specified in the Find 
What box.

Direction
If Up is selected, find searches from the current point towards the beginning of the document.    If 
Down is selected, find searches from the current point towards the end of the document.

Find Next
Finds and selects the next occurrence of the text in the Find What box.

Cancel
Cancels the current find command and causes the Find dialog to be removed.

Help
Presents this help.



Replace command (Edit menu)

Use this command to replace text within a Web Spinner document.



Replace dialog box

Searches for and replaces specified text in the active Web Spinner document.

Find What:
Type, or insert the information you that to find.

Replace With:
Type the text you want to use as replacement text, or paste it from the Clipboard.    To delete the text 
in the Find What box from the document, leave the Replace With box empty.

Match Case
Finds only text with the exact combination of uppercase and lowercase letters specified in the Find 
What box.

Find Next
Finds and selects the next occurrence of the text in the Find What box.

Replace
Changes the selected text to the text in the Replace With box, and then finds the next occurrence.

Replace All
Finds and replaces all occurrences of the text in the Find What box with the text in the Replace With 
box.

You can also undo the replacements    See Undo Command.

Cancel
Cancels the current find command and causes the Find dialog to be removed.

Help
Presents this help.



Modifying the Document

Welcome to Web Spinner.    You can get help within Web Spinner several different ways:

Press F1 when you have the cursor in front of any HTML tag.
Press F1 on any dialog (or press the Help button if there is on).
Select Help from the Web Spinner menu.
Use the Help tool bar button and then click on any part of the Web Spinner screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Registration Benefits

Why Should I Register Web Spinner?

Here are 14 good reasons:

1. To get rid of the "Reminder" screen when you start the program.
2. To get a printed manual (optional).
3. To get a discount on the JCSM Shareware Collection CD. (only $9.95 U.S.)
4 . To receive a discounted CompuServe membership.
5. To receive a professionally printed HTML quick reference card.
6. To receive additional templates.
7. To get free minor version updates.
8. To get discounted major version updates.
9. To get bug fixes and upgrade notices.
10. To get our newsletter containing Web tips, tricks, company information etc.

(Feel free to submit articles for the newsletter!)
11. To be eligible for full technical support.
12. To be eligible for Best Spun WebTM annual contest.
13. To receive a copy of "How to Compose Good HTML" (printed and on disk)
14. It's the right thing to do.



Insert File (File Menu)

This command inserts a file at the current location in the Web Spinner document.



Word Wrap (Edit Menu)

This command turns word wrapping on or off for the current document.    The menu item is checked if 
word wrapping is turned on.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts
Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Web Spinner is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Document Structure Elements

<HTML> HTML identifier
<HEAD> Head element
<BODY> Body element



Anchor Elements

<A> Anchor Element



Block Formatting Elements

<ADDRESS> Address element
<BODY> Body element
<BLOCKQUOTE> Blockquote element
<HEAD> Head element
<Hn> Heading element (n = 1 - 6)
<HR> Horizontal rule element
<HTML> HTML identifier
<BR> Line break element
<P> Paragraph element
<PRE> Preformatted text element
<TITLE> Title element



List Elements

<DL> Definition list element
<DIR> Directory list element
<LI> List item element
<MENU> Menu list element
<OL> Ordered list element
<UL> Unordered list element



Information and Character Formatting Elements

<B> Bold element
<CITE> Citation element
<CODE> Code element
<EM> Emphasis element
<I> Italics element
<KBD> Keyboard element
<SAMP> Sample element
<STRONG> Strong element
<TT> Typetype element
<VAR> Variable element



Image Elements

<IMG> Image element



Special Character Elements



Teletype Font

HTML Level: 2

<TT> ... </TT>

The Teletype element specifies that the text should be displayed in fixed-with typewriter font.

Shortcuts
Toolbar:



Bold

HTML Level: 2

</B> ... </B>

The Bold element specifies that the text should be displayed in boldface, where available.

Shortcuts
Toolbar:

Keys: CTRL+B



Italic

HTML Level: 2

<I> ... </I>

The Italic element specifies that the text should be displayed in italics font, where available.

Shortcuts
Toolbar:

Keys: CTRL+I



Underline

HTML Level: Proposed

<U> ... </U>

The Underline element is proposed to indicate that the text should be displayed as underlined.

Shortcuts
Toolbar:

Keys: CTRL+U



Edit Link Dialog

The Edit Link dialog allows you to easily create link within the current document or to other sources.    
Select the server type of the Server Type dropdown list.    The options that will need to be entered will 
change based on the server type that was selected.

Also See:

FTP
HTTP
GOPHER
MAILTONEWS
TELNET
WAIS
Shortcuts

Toolbar:
Keys: CTRL+L



Edit Image Dialog

The Edit Image Dialog allows you to easily include graphic images in your document

Alignment

Top Aligns text with the top of the image
Middle Aligns text with the middle of the image
Bottom Aligns text with the bottom of the image

Path & File Name

Editor the path name and file name of the image.    If the image will be in the same path as the HTML 
document, only the file name is required.

Shortcuts
Toolbar:

Keys: CTRL+G



Toolbars tab

The Toolbars tab allows you to select which toolbars should be displayed when Web Spinner begins and 
if ToolTips should be displayed.

ToolBars

Check the toolbars that you wish to display when Web Spinner begins.

ToolTips

Show Show the ToolTips
Hide Hide the ToolTips



Defaults tab

The Defaults tab allows you the change the default behavior of Web Spinner.

Start New Document With DEFAULT HTML Template

If this option is checked new documents will be created with a default HTML template.

Custom Default HTML Template

If you would like to create a custom default template, you can with Web Spinner.    The template can 
contain any HTML commands that you desire.    The file should be saved with a .tpl extension.

Web View for Testing

Enter the drive and pathname to the program that you use for viewing World Wide Web pages.    Web 
Spinner will use this program to test and display your Web pages.    The test program should include the 
full path to the program if the program is not in your path.    If the program is in your path, then only the 
program name is required.

Browse Button

The Browse Button will bring up a dialog similar to the File Open dialog to select the World Wide Web 
viewing program.

Convert DOS paths to Unix paths

If this option is checked all pathnames will be converted from DOS format paths to Unix style paths.



Host tab

The Host information is used as a default whenever a host name or home directory is required.    

Host Name

This is the hostname of your Internet Provider

Home Directory

This is the path name to your home directory.    It may be a full pathname or a relative path name.



Author tab

The information on the Author tab will be used to create the Author block in the Web Spinner document.    
The format of the Author Block is:

<AUTHOR>
Author Name Author Information Author E-Mail Address
</AUTHOR>

Note: The Author Block is only created automatically if the Start New 
Documents with Default HTML Template is checked on the Defaults 
tab

Author Name

This is your name or your company name

Author Information

Any information that you wish to provide

Author E-Mail Address

This is your e-mail address or your company e-mail address.



Definition

HTML Level: Proposed

<DFN> ... </DFN>

The Defining Instance element indicates the defining instance of a term.    The typical rendering is bolded 
or bold italics.    This element is not widely supported.



Emphasis

HTML Level: 2

<EM> ... </EM>

The Emphasis element indicates typographic emphasis, typically displayed in italics.



Citation

HTML Level: 2

<CITE> ... </CITE>

The Citation element indicates a citation; typically displayed as italics.



Source Code

HTML Level: 2

<CODE> ... </CODE>

The Code elements indicates an example of code; typically displayed as monospaced.

Also See

Preformatted



Keyboard

HTML Level: 2

<KBD> ... </KBD>

The Keyboard element indicated text typed by a user.    Typically displayed as monospaced.



<???> Status Message



Strong

HTML Level: 2

<STRONG> ... </STRONG>

The Strong element indicates a strong typographic emphasis, typically displayed in bold.



<H1> First level heading
The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



<H2> Second level heading

The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



<H3> Third level heading

The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



<H4> Fourth level heading

The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



<H5> Fifth level heading

The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



<H6> Sixth level heading

The HTML specification defines six levels of heading.    Level 1 is the most prominent and level 6 is the 
least prominent.

Shortcuts
Toolbar:



Options...
The options menu items allows you to customize the overall behavior of Web Spinner.    Customizable 
options include:

Defaults
Author
Hosts
Toolbars



Find Next
The find next command repeats the last find command.    The find next searches in the same direction as 
the original find command.

Shortcuts
Toolbar:

Keys: F3



Paragraph

HTML Level: 0

<P>

The Paragraph element indicates a paragraph.

Shortcuts
Toolbar:



Link Anchor

HTML Level 0

<A> SCHEME:SCHEME-SPECIFIC-PART </A>

Schemes

FTP
HTTP
GOPHER
MAILTO
NEWS
TELNET
WAIS

Shortcuts
Toolbar:

Keys: CTRL+L



FTP Scheme

FTP://[login[/path]] [;TYPE= A | I | D]]

login Optional login name.    If login is not supplied, the login anonymous is assumed and 
login@hostname is passed as a password

path The path to the file to be retrieved or to the directory to be listed.

TYPE= A = ASCII transfer
I = Binary transfer
D = Directory listing



HTTP Scheme

HTTP://host:[port]/path[?searchpart]

host The fully qualified domain name of a network host or its IP address.

port The port number to connect to.    If this is left at 0 it will default to 80

path The absolute or relative path to the item.

searchpart An optional search criterion



Gopher Scheme

GOPHER://host:[port]/gopher-path

Where gopher-path is one of

<gophertype><selector>
<gophertype><selector>%09<search>
<gophertype><selector>%09<search>%09<gopher+_string>

host The fully qualified domain name of a network host or its IP address

port The port number to connect to.    If this is left at 0 it will default to 70

gophertype A single-character field to denote the Gopher resource.



MAILTO Scheme

MAILTO://email-address

email-address A valid Internet e-mail address



News Scheme

NEWS://newsgroup-name

newsgroup-name A period-delimited name for the newsgroup such as 
comp.infosystems.www.misc.



NNTP Scheme

NNTP://host:[port]/newsgroup-name/[article-number]

host The fully qualified domain name of a network host or its IP address

port The port number to connect to.    If this is left at 0 it will default to 119

newsgroup-name A period-delimited name for the newsgroup such as 
comp.infosystems.www.misc.

article-number The numeric id of the article within the newsgroup



Telnet Scheme

TELNET://[user[:password]]@host[;port]

usert An optional user id use to log-on to the system
password An optional password for User
host The fully qualified domain name of a network host or its IP address
port The port number to connect to.    If this is left at 0 it will default to 23



WAIS Scheme

WAIS://host[:port]/database
- or -
WAIS://host[:port]/database?search
- or -
WAIS://host[:port]/database/wtype/wpath

host The fully qualified domain name of a network host or its IP address

port The port number to connect to.    If this is left at 0 it will default to 210

database The name of the WAIS database being queried

search The item being searched for

wtype A particular document within a WAIS database

wtype WAIS document id



Image

HTML Level 0:

<IMG [ALIGN= TOP | MIDDLE | BOTTOM] [ALT=] SRC= [ISMAP] >

The Image element is used to incorporate in-line graphics into an HTML document.    This element cannot 
be used for embedding other HTML text.

ALIGN = TOP | MIDDLE | BOTTOM The ALIGN attribute accepts the values TOP, MIDDLE or 
BOTTOM, which specifies if the following lines of text are 
aligned with the top, middle, or bottom of the graphic.

ALT= Optional text as an alternative to the graphic for rendering 
in non-graphical environments.    Alternate text is 
mandatory for Level 0 documents.    Web Spinner requires 
alternate text.

SCR= The value of the SRC attribute is the URL of the document
to be embedded.    Only images can be embedded, not 
HTML text.    The syntax of SRC is the same as that of the 
HERF attribute of the <A> tag.    SRC is mandatory

ISMAP The ISMAP (is map) attribute identifies an image as an 
image map.    Image maps are graphics in which certain 
regions are mapped to URLs.    By clicking on different 
regions, different resources can be accessed from the 
same graphic.

Shortcuts
Toolbar:

Keys: CTRL+G



Line Break

HTML Level: 0

<BR>

The Line Break element specifies that a new line must be started at the given point.    A new line indents 
the same as that of line-wrapped text.

Shortcuts
Toolbar:



Horizontal Line

HTML Level: 0

<HR>

A Horizontal Rule element is a divider between sections of text such as a full width horizontal rule or 
equivalent graphic.

Shortcuts
Toolbar:



List Item

HTML Level: 0

<LI>

The List Element is used to designate an item within a list.

Also See

Definition List
Directory List
Menu List
Ordered List
Unordered List
Shortcuts

Toolbar:



Unordered List

HTML Level: 0

<UL> ... </UL>

The Unordered List element is used to present a list of items which is typically separated by white space 
and/or marked by bullets.

An unordered list must begin with the <UL> tag which is immediately followed by a <LI> (list item) tag.

Also See

Definition List
Directory List
Menu List
Ordered List
Shortcuts

Toolbar:



Ordered List

HTML Level: 0

<OL> ... </OL>
The Ordered List element is used to present a numbered list of items, sorted by sequence or order of 
importance.

An ordered list must begin with the <OL> tag which is immediately followed by a <LI> (list item) tag.

Also See

Definition List
Directory List
Menu List
Unordered List
Shortcuts

Toolbar:



Definition List

HTML Level: 0

<DL> ... </DL>

A Definition List is a list of terms and corresponding definitions.    Definition lists are typically formatted wit 
the term flush-left and the definition, formatted paragraph style, indented after the term.

Also See

Directory List
Menu List
Ordered List
Unordered List



Directory List

HTML Level: 0

<DIR> ... </DIR>

A Directory List element is used to present a list of items containing up to 20 characters each.    Items in a 
directory list may be arranged in columns, typically 24 characters wide.

A directory list must begin with the <DIR> tag which is immediately followed by a <LI> (list item) tag.
Also See

Definition List
Menu List
Ordered List
Unordered List



Menu List

HTML Level: 0

<MENU> ... <MENU>

A Menu List is a list of items with typically one line per item.    The menu list style is more compact that the
style of an unordered list.

A menu list must begin wit a <MENU> tag which is immediately followed by a <LI> (list item) tag.
Also See

Definition List
Directory List
Ordered List
Unordered List



Block Quote

HTML Level: 0

<BLOCKQUOTE> ... </BLOCKQUOTE>

The Blockquote element is used to contain text quoted from another source.

A typical rendering might be a slight extra left and right indent, and/or italic font.    The Blockquote element
causes a paragraph break, and typically provides space above and below the quote.

Shortcuts
Toolbar:



Test HTML

Shortcuts
Toolbar:



Begin an HTML Document

HTML Level: 0

<HTML> ... </HTML>

The HTML identifier defines the document as containing HTML elements.



HEAD

HTML Level: 0

<HEAD> ... <HEAD>

The HEAD identifier defines the heading part of the document.



Title

HTML Level: 0

<TITLE> ... </TITLE>

Every HTML document must contain a Title element.    The title should identify the contents of the 
document in a global context, and may be used in a history list and as a label for the window displaying 
the document.    Unlike headings, titles are not typically displayed in the test of a document itself.

The title element must occur within the head of the document, and may not contain anchors, paragraph 
tags, or highlighting.    Only one title is allowed in a document.



Body

HTML Level: 0

<BODY> ... </BODY>

The Body element identifies the body component of an HTML document.    Specifically, the body of the 
document may contain links, text and formatting information within the <BODY> and </BODY> tags.



Address

HTML Level: 0

<ADDRESS> ... </ADDRESS>

The address element specifies such information as address, signature and authorship, often at the top or 
bottom of a document.

Typically, an Address is displayed in an italic typeface and may be indented.    The Address element 
implies a paragraph break before and after.



Special Characters

Glyph Name Syntax Description

< lt &lt; Less than sign
> gt &gt; Greater than sign
& amp &amp; Ampersand

quot &quot; Double quote sign

Á Aacute &Aacute; Capital A, acute accent
À Agrave &Agrave; Capital A, grave accent
Â Acirc &Acirc; Capital A, circumflex accent
Ã Atilde &Atilde; Capital A, tilde
Å Aring &Aring; Capital A, ring
Ä Auml &Auml; Capital A, dieresis or umlaut mark
Æ AElig &AElig; Capital AE diphthong (ligature)
Ç Ccedil &Ccedil; Capital C, cedilla
É Eacuete &Eacute; Capital E, acute accent
È Egrave &Egrave; Capital E, grave accent
Ê Ecirc &Ecirc; Capital E, circumflex accent
Ë Euml &Euml; Capital E, dieresis or umlaut mark
Í Iacute &Iacute; Capital I, acute accent
Ì Igrave &Igrave; Capital I, grave accent
Î Icirc &Icirc; Capital I, circumflex accent
Ï Iuml &Iuml; Capital I, dieresis or umlaut mark
Ð ETH &ETH: Capital Eth, Icelandic
Ñ Ntilde &Ntilde Capital N, tilde
Ó Oacute &Oacute; Capital O, acute accent
Ò Ograve &Ograve; Capital O, grave accent
Ô Ocirc &Ocirc; Capital O, circumflex accent
Õ Otilde &Otilde; Capital O, tilde
Ö Ouml &Ouml; Capital O, dieresis or umlaut mark
Ø Oslash &Oslash; Capital O, slash
Ú Uacute &Uacute; Capital U, acute accent
Ù Ugrave &Ugrave; Capital U, grave accent
Û Ucirc &Ucirc; Capital U, circumflex accent
Ü Uuml &Uuml; Capital U, dieresis or umlaut mark
Ý Yacute &Yacute; Capital Y, acute accent

Þ THORN &THORN; Capital THORN, Icelandic
ß szlig &szlig; Small sharp s, German (sz ligature)

Contacting FLFSoft, Inc.

For technical assistance, order, site licenses, upgrades or general information, you many contact us at:

Address: FLFSoft, Inc.
PO. Box 306
Oak Creek, WI 53154-0306

CompuServe: 75010,237
Internet: orders@flfsoft.com or

support@flfsoft.com





Disclaimer Of Warranty
TRIAL USE (SHAREWARE EVALUATION VERSION) WARRANTY:
The Shareware evaluation (trial use) version is provided AS IS. FLFSoft, Inc. 
MAKES NO WARRANTY OF ANY KIND, EXPRESSED OR IMPLIED, INCLUDING WITHOUT 
LIMITATION, ANY WARRANTIES OF MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR 
PURPOSE.
REGISTERED VERSION ONLY WARRANTY:
FLFSoft, Inc. warrants the physical diskette(s) and physical documentation provided with registered 
versions to be free of defects in materials and workmanship for a period of ninety days from the date of 
registration.    If FLFSoft, Inc. receives notification within the warranty period of defects in materials or 
workmanship, and such notification is determined by FLFSoft, Inc. to be correct, FLFSoft, Inc. will replace 
the defective diskette(s) or documentation.

The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to 
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or 
right to recover any other damages, including but not limited to, loss of profit, data, or use of the software, 
or special, incidental, or consequential damages or other similar claims, even if FLFSoft, Inc. has been 
specifically advised of the possibility of such damages.    In no event will FLFSoft, Inc. liability for any 
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for 
the license to use the software, regardless of any form of the claim.
FLFSoft, Inc. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY AND/OR 
FITNESS FOR A PARTICULAR PURPOSE.



Copyright Notice

Copyright (c) 1995 FLFSOFT, INC.    All Rights Reserved

No part of this publication may be copied without the express written permission of 

FLFSOFT, INC., 
PO. Box
306 Oak Creek, WI 53154-0306



Definition of Shareware

Shareware distribution gives users a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register.    Individual programs differ on details -- some
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with a printed 
manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below.    Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may copy 
their Shareware.

Shareware is a distribution method, not a type of software.    You should find software that suits your 
needs and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your 
needs easier, because you can try before you buy. And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.

(This section written by Paul Mayer, the author of GRAB Plus, and provided courtesy of the Association of
Shareware Professionals.)



LICENSE

This section contains important license information regarding the use of Web Spinner, Version 1.00.    This
information applies to individual users who wish to pass copies out to friends and associates.

User Groups, Computer Clubs, Disk Vendors and Distributors, Subscription Services, Disk-of-the-Month 
Clubs, etc., should refer to the VENDOR.DOC file on the distribution disk for complete 
information relating to them.

BBS SYSOPs should refer to the SYSOP.DOC file on the distribution disk for complete information 
relating to them.

PLEASE!    Show your support for Shareware by registering the programs you actually use.    FLFSoft, Inc.
depends upon and needs your support.    Thank you!

Trial Use License:

Web Spinner is NOT a public domain program.    It is Copyright (c) 1995    by FLFSoft, Inc.    All rights 
reserved.

This software and accompanying documentation are protected by United States Copyright law and also 
by International Treaty    provisions.    Any use of this software in violation of Copyright    law or the terms of
this limited license will be prosecuted to the best of our ability.    The conditions under which you may copy
this software and documentation are clearly outlined below under    "Distribution Restrictions".

FLFSoft, Inc. hereby grants you a limited license to use this software for evaluation purposes for a period 
not to exceed sixty (60) days.    If you intend to continue using this software (and/or it's documentation) 
after the sixty (60) day evaluation period, you MUST make a registration payment to FLFSoft, Inc.

Using this software after the sixty (60) day evaluation period, without registering the software is a violation
of the terms of this limited license.

Licensee shall not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse 
engineer, or transfer the licensed program except as provided in this agreement.    Any such unauthorized 
use shall result in immediate and automatic termination of this license.
All rights not expressly granted here are reserved to FLFSOFT, Inc.

Limited Distribution License:

As the copyright holder for Web Spinner, FLFSoft, Inc.    authorizes distribution by individuals only in 
accordance with the following restrictions.

(User Groups, Computer Clubs, Disk Vendors and Distributors, Subscription Services, Disk-of-the-Month 
Clubs, etc., should refer to the VENDOR.DOC file on the distribution disk for complete information relating
to them.)

(BBS SYSOPs should refer to the SYSOP.DOC file on the distribution disk for complete information 
relating to them.)

Individuals are hereby granted permission by FLFSoft, Inc. to    copy the Web Spinner diskette for their 
own use (for evaluation purposes) or for other individuals to evaluate, ONLY when the following 
conditions are met.

The Web Spinner package is defined as containing all the material listed in the PACKING.LST text file.    If



any files listed in the PACKING.LST text file, or the PACKING.LST file itself, are missing, then the 
package is not complete and distribution is forbidden.    Please contact us to obtain a complete package 
suitable for distribution.

o    The Web Spinner package - including all related program files and documentation files - CANNOT be 
modified in any way and must be distributed as a complete package, without exception.    The 
PACKING.LST text file contains a list of all files that are part of the Web Spinner package.

o    No price or other compensation may be charged for the Web Spinner package.    A distribution cost 
may be charged for the cost of the diskette, shipping and handling, as long as the total (per disk) does not
exceed US$8.00 in the U.S. and Canada, or US$12.00 internationally.

o    The Web Spinner package CANNOT be sold as part of some other inclusive package.    Nor can it be 
included in any commercial software packaging offer, without a written agreement from FLFSoft, Inc.

o    The PRINTED User's Guide may not be reproduced in whole or in part, using any means, without the 
written permission of FLFSoft, Inc.    In other words, the disk-based documentation may not be distributed 
in PRINTED (hardcopy) form.

o    The Web Spinner package cannot be "rented" or "leased" to others.

o    Licensee shall not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse 
engineer, or transfer the licensed program except as provided in this agreement.    Any such unauthorized 
use shall result in immediate and automatic termination of this license.

o    U.S. Government Information:    Use, duplication, or disclosure by the U.S. Government of the 
computer software and documentation in this package shall be subject to the restricted rights applicable 
to commercial computer software as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and 
Computer Software clause at 252.227-7013 (DFARS 52.227-7013).    The Contractor/manufacturer is 
FLFSoft, Inc., P.O. Box 306 Oak Creek, Wisconsin, 53154-0306.
All rights not expressly granted here are reserved to FLFSoft, Inc.



Order by Mail

Click here to print the order form

Name: ________________________________________________________

Address: ________________________________________________________

City: ________________________ State: _______ Zip: ____________

Country: __________________________ Telephone: ____________________

E-Mail Address    ________________________________________________________

Circle Disk Size: 5 1/4" 3 1/2"           Circle Graphics: EGA    VGA    SVGA

Circle Computer Type: 286    386    486    Other

Web Spinner v1.0 (Windows) $29.00 (US) x ___ Units = $ _____
Web Spinner v1.0 (Windows NT) $29.00 (US) x ___ Units = $ _____
Web Spinner v1.0 (Windows 95) $29.00 (US) x ___ Units = $ _____
Web Spinner Printed Manual $7.50      (US) x ___ Units = $ _____

U.S. shipping and handling $1.50 (US) = $ _____
Canadian Shipping $2.00 (US) = $ _____
International shipping and handling $5.00 (US) = $ _____

Wisconsin sales tax (Wisconsin Residents ONLY) = $ _____

Total       $ _____

Mail to: FLFSoft, Inc.
PO. Box 306
Oak Creek, WI 53154-0306

Make checks payable to "FLFSOFT, INC.".    We will attempt to ship all orders within 24 hours.

Where did you obtain this copy of Web Spinner?

_________________________________________________________________________

_________________________________________________________________________

Please pass along any comments or suggestions about Web Spinner.

_________________________________________________________________________

_________________________________________________________________________

Thank you for your comments!

FLFSoft, Inc.



Order by Credit Card

You can register Web Spinner with Master Card, Visa, American Express, or Discover card from Public 
(software) Library by calling    PsL at one of the following numbers 800-2424-PsL or 713-524-6394 or by 
FAX at 713-524-6398 or by CIS Email at 71355,470.    You can also mail credit card orders to Psl at:

Public (software) Library
P.O. Box 35705
Houston, TX 77235-5705

Web Spinner is product number 14030.

"THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY"

Registrations are taken by PsL as a convience to FLFSoft, Inc. customers.    Any questions about the 
status of shipment of the order, refunds, registrations options, product details, technical support, volume 
discounts, dealer pricing, site licenses, etc., must be directed to FLFSoft, Inc.

To insure that you get the latest version, PsL will notify FLFSoft the day of your order and we will ship 
Web Spinner directly to you.

Also see

Contacting FLFSoft, Inc.
Order by Mail
Order by CIS Email



Order by CompuServe Shareware Registration Service

You may register your copy of Web Spinner by using CompuServe Shareware Registration service.    To 
register Web Spinner on CompuServe GO SWREG.    Web Spinners registration id is: 5973.    You can 
also search for FLFSoft or our search on our compuserve id 75010,237.    Follow the instructions in 
SWREG to register Web Spinner.

Also see

Contacting FLFSoft, Inc.



Order via Email to FLFSoft, Inc.

You can register your copy of Webspinner by sending an email to FLFSoft, Inc.    We will ship the software
to you and send you an invoice.

Also see

Contacting FLFSoft, Inc.




